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Important Note on New Product
Names

As part of Sun’s new developer product strategy, we have changed the names of our

development tools from Sun WorkShop™ to Forte™ Developer products. The

products, as you can see, are the same high-quality products you have come to

expect from Sun; the only thing that has changed is the name.

We believe that the Forte™ name blends the traditional quality and focus of Sun’s

core programming tools with the multi-platform, business application deployment

focus of the Forte tools, such as Forte Fusion™ and Forte™ for Java™. The new

Forte organization delivers a complete array of tools for end-to-end application

development and deployment.

For users of the Sun WorkShop tools, the following is a simple mapping of the old

product names in WorkShop 5.0 to the new names in Forte Developer 6.

In addition to the name changes, there have been major changes to two of the

products.

■ Forte for High Performance Computing contains all the tools formerly found in

Sun Performance WorkShop Fortran and now includes the C++ compiler, so High

Performance Computing users need to purchase only one product for all their

development needs.

■ Forte Fortran Desktop Edition is identical to the former Sun Performance

WorkShop Personal Edition, except that the Fortran compilers in that product no

longer support the creation of automatically parallelized or explicit, directive-

based parallel code. This capability is still supported in the Fortran compilers in

Forte for High Performance Computing.

We appreciate your continued use of our development products and hope that we

can continue to fulfill your needs into the future.

Old Product Name New Product Name

Sun Visual WorkShop™ C++ Forte™ C++ Enterprise Edition 6

Sun Visual WorkShop™ C++ Personal

Edition

Forte™ C++ Personal Edition 6

Sun Performance WorkShop™ Fortran Forte™ for High Performance Computing 6

Sun Performance WorkShop™ Fortran

Personal Edition

Forte™ Fortran Desktop Edition 6

Sun WorkShop Professional™ C Forte™ C 6

Sun WorkShop™ University Edition Forte™ Developer University Edition 6
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Preface

What’s New in Sun WorkShop 6 update 1 describes the new features of the

Sun WorkShop™ 6 update 1 compilers and tools.

Multiplatform Release

This Sun WorkShop release supports versions 2.6, 7, and 8 of the Solaris™ SPARC™
Platform Edition and Solaris™ Intel Platform Edition Operating Environments.

The Solaris operating environment runs on two types of hardware or platforms—

SPARC and IA. The Solaris environment also runs on both 64-bit and 32-bit address

spaces. The information in this document pertains to both platforms and address

spaces unless called out in a special section, note, bullet, example, or code example.

The terms “IA” and “x86” refer to the Intel 8086 family of microprocessor chips,

including the Pentium, Pentium Pro, and Pentium II processors and compatible

microprocessor chips made by AMD and Cyrix. In this document, the term “x86”

refers to the overall platform architecture, whereas Intel Platform Edition appears in

the product name.
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Access to Sun WorkShop Development

Tools

Because Sun WorkShop product components and man pages do not install into the

standard /usr/bin/ and /usr/share/man directories, you must change your

PATHand MANPATHenvironment variables to enable access to Sun WorkShop

compilers and tools.

To determine if you need to set your PATHenvironment variable:

1. Display the current value of the PATHvariable by typing the following at a
prompt.

2. Review the output for a string of paths containing /opt/SUNWspro/bin/ .

If you find the paths, your PATHvariable is already set to access Sun WorkShop

development tools. If you do not find the paths, set your PATHenvironment variable

by following the instructions in this section.

To determine if you need to set your MANPATHenvironment variable:

1. Request the workshop man page by typing the following at a prompt.

2. Review the output, if any.

If the workshop (1) man page cannot be found or if the man page displayed is not

for the current version of the software installed, follow the instructions in this

section for setting your MANPATHenvironment variable.

Note – The information in this section assumes that your Sun WorkShop products

are installed in the /opt directory. If your Sun WorkShop products are not installed

in the /opt directory, contact your system administrator for the equivalent path on

your system.

% echo $PATH

% man workshop
2 What’s New in Sun WorkShop 6 update 1 • October 2000



The PATHand MANPATHvariables should be set in your home .cshrc file if you are

using the C shell or in your home .profile file if you are using the Bourne or Korn

shells.

■ To use Sun WorkShop commands, add the following to your PATHvariable:

/opt/SUNWspro/bin

■ To access Sun WorkShop man pages with the mancommand, add the following to

your MANPATHvariable:

/opt/SUNWspro/man

For more information about the PATHvariable, see the csh (1), sh (1), and ksh (1)

man pages. For more information about the MANPATHvariable, see the man(1) man

page. For more information about setting your PATHand MANPATHvariables to

access this release, see the Sun WorkShop 6 Installation Guide or your system

administrator.

Typographic Conventions

TABLE P-1 shows the typographic conventions that are used in Sun WorkShop

documentation.

TABLE P-1 Typographic Conventions

Typeface Meaning Examples

AaBbCc123 The names of commands, files,

and directories; on-screen

computer output

Edit your .login file.

Use ls -a to list all files.

% You have mail .

AaBbCc123 What you type, when

contrasted with on-screen

computer output

% su
Password:

AaBbCc123 Book titles, new words or terms,

words to be emphasized

Read Chapter 6 in the User’s Guide.

These are called class options.

You must be superuser to do this.

AaBbCc123 Command-line placeholder text;

replace with a real name or

value

To delete a file, type rm filename.
Preface 3



Related Documentation

For more information about this product, see the following sources. (The names of

our development tools have changed from Sun WorkShop™ to Forte™ Developer

products; you might see both product names used.)

Note – If your Sun WorkShop 6 update 1 software is not installed in the /opt
directory, ask your system administrator for the equivalent path on your system.

■ Man pages and readmes. This documentation describes the new features,

performance enhancements, problems and workarounds, and software

corrections in this Sun WorkShop 6 update 1 release.

You can access these documents in HTML on your local system or network by

pointing your browser to file:/opt/SUNWspro/docs/index.html .

■ The Sun WorkShop and Sun WorkShop TeamWare online help. The online help

has been updated for the new features in this Sun WorkShop 6 update 1 release.

You can access the online help on your local system or network by pointing your

browser to file:/opt/SUNWspro/docs/index.html . You can also access the

online help from the Help menu in the Sun WorkShop products.

■ What’s New in Sun WorkShop 6 update 1. This document describes the new features

in this Sun WorkShop 6 update 1 release and in the Sun WorkShop 6 release.

You can access this book on your local system or network by pointing your

browser to file:/opt/SUNWspro/docs/index.html . You can also access it by

pointing your browser to http://docs.sun.com and searching for the Forte

Developer 6 update 1 collection.

■ Sun WorkShop 6 manuals. These manuals were provided with Sun WorkShop 6.

Information in the Sun WorkShop 6 update 1 man pages, readmes, and online

help supersedes information in the Sun WorkShop 6 manuals.

You can access the manuals on your local system or network by pointing your

browser to file:/opt/SUNWspro/docs/index.html . You can also access

them by pointing your browser to http://docs.sun.com and searching for the

Forte C, Forte C++, Forte for High Performance Computing, and Forte TeamWare

products.
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The following Sun WorkShop manuals are not available through

http://docs.sun.com . You can access them on your local system or network

by pointing your browser to file:/opt/SUNWspro/docs/index.html .

■ Sun WorkShop Memory Monitor User’s Manual
■ Standard C++ Class Library Reference
■ Standard C++ Library User’s Guide
■ Tools.h++ Class Library Reference
■ Tools.h++ User’s Guide
■ Sun Performance Library Reference

■ Sun WorkShop 6 update 1 supplements. The supplements provide more detailed

information on some of the major new features in this Sun WorkShop 6 update 1

release.

You can access the supplements by pointing your browser to

http://docs.sun.com and searching for the Forte Developer 6 update 1

collection. The supplements are not available on your local system or network

because they are not on the Forte Developer 6 update 1 CD.

■ Sun WorkShop 6 update 1 Release Notes. These notes provide installation-related

and late-breaking information about this Sun WorkShop 6 update 1 release.

Information in the release notes supersedes information in any of the other

documentation.

The release notes are available as a text file on the Forte Developer 6 update 1 CD

at /cdrom/devpro_v8n1_ platform/release_notes.txt (where platform is

either sparc or intel) . The release notes are also available in HTML on the

Forte Developer Products Hot News page by pointing your browser to

http://www.sun.com/forte/developer/hotnews.html .
Preface 5
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CHAPTER 1

New Features in Sun WorkShop 6
update 1

This chapter describes the new features of the Sun WorkShop™ 6 update 1 compilers

and tools. The primary focus of this release is improved performance on the

UltraSPARC™ III processor.

Each updated Sun WorkShop component has a section that includes a table that

summarizes the new features. Explanations of some new features follow the

summary tables.

This chapter has the following sections:

■ “C Compiler” on page 8

■ “C++ Compiler” on page 15

■ “Fortran Compilers” on page 28

■ “Interval Arithmetic” on page 31

■ “dbx ” on page 35

■ “Sun Performance Library” on page 35

■ “Sampling Analyzer” on page 36
7



C Compiler
TABLE 1-1 lists the new features available with the Sun WorkShop 6 update 1 release

of the C compiler. Some of the features are described in greater detail in the sections

following the table.

TABLE 1-1 C Compiler New Features

Feature Option or Macro Description

Support for the

UltraSPARC III

Processor

-xtarget
-xchip

The -xtarget and -xchip options

now accept ultra3 . See the

following discussion for the

recommended flags to use for

optimal UltraSPARC III performance.

Optimizing

Through Type-

Based Analysis

-xalias_level The C compiler now accepts options

and pragmas which allow it to

perform type-based alias analysis

and optimizations.

Enhancing

Math Routine

Performance

With New

Pragmas

__MATHERR_ERRNO_DONTCARE cc -fastnow expands to include

the macro

__MATHERR_ERRNO_DONTCARE. This

macro causes math.h in the Solaris 8

operating environment to assert

performance-related pragmas for

some of the math routines prototyped

in math.h .

Inlining

Standard

Library

Functions

-xbuiltin Use this command to improve

performance of generated code

through substitution of intrinsics, or

inlining, of standard library functions

where the compiler determines it is

profitable.
8 What’s New in Sun WorkShop 6 update 1 • October 2000



Support for the UltraSPARC III Processor

Use the following options to compile for optimal performance when compiling and

running your program on an UltraSPARC III processor:

-fast -xcrossfile -xprofile={collect:|use:}

■ For cross-compilation (compiling on a platform other than UltraSPARC III but

generating object binaries to run on an UltraSPARC III system), add the following

options to insure correct cache sizes and optimization strategies:

-xtarget=ultra3 -xarch={v8plusb|v9b}

■ Specify -xarch=v8plusb for 32-bit code generation and v9b for 64-bit code. For

programs accessing very large data files, 64-bit code provides better performance.

However, -xarch=v9b should only be used when 64-bit code generation is

required. In some cases it can result in slower performance.

■ The -fast option enables optimizations that favor speed of execution and raises

the optimization level to -xO5 . Note that -fast allows substitution of faster

arithmetic operations where possible (-fsimple=2 ), so some inaccuracies might

result.

■ -xcrossfile enables the compiler to apply optimizations across all the source

files specified on the command line, including some interprocedural

optimizations.

■ -xprofile={collect:|use:} enables program performance profiling.

Profiling allows the compiler to identify the most frequently executed sections of

code and to perform localized optimizations to best advantage.

Enabling and

Disabling

Trigraph

Recognition

-xtrigraphs The new -xtrigraphs option

enables and disables trigraph

translation.

Prefetch

Latency

Specifier

-xprefetch= ...,latx: factor This new suboption determines how

far apart the instruction the compiler

generates to prefetch data will be

from the subsequent use of the data

in a load or store instruction.

Overriding the

Default Search

Path With the

-I- Option

-I- The new -I- option gives you more

control over the algorithm that the

compiler uses when searching for

include files.

TABLE 1-1 C Compiler New Features (Continued)

Feature Option or Macro Description
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Note – Programs compiled specifically for the UltraSPARC III platform with

-xarch={v8plusb|v9b} will not operate on platforms other than the

UltraSPARC III platform. Use -xarch={v8plusa|v9a} to compile programs to run

compatibly on UltraSPARC I, UltraSPARC II, and UltraSPARC III platforms.

Optimizing Through Type-Based Analysis

You can use the new -xalias_level C compiler command and several new

pragmas to enable the compiler to perform type-based alias analysis and

optimizations. Use these extensions to express type-based information about the

way pointers are used in your C program. The C compiler uses this information, in

turn, to do a significantly better job of alias disambiguation for pointer-based

memory references in your program.

For more information on this new compiler command, see the C User’s Guide
Supplement available from http://docs.sun.com (in the

Forte™ Developer 6 update 1/Sun WorkShop 6 update 1 Collection).

Enhancing Math Routine Performance With New

Pragmas

Now when you issue the -fast option, the macro __MATHERR_ERRNO_DONTCAREis

defined. This macro causes math.h in the Solaris 8 operating environment to assert

performance-related pragmas such as the following for some math routines

prototyped in <math.h> :

■ #pragma does_not_read_global_data

■ #pragma does_not_write_global_data

■ #pragma no_side_effect

If your code relies on the return value of errno in exceptional cases as documented

in the matherr (3M) man page, you must turn off the macro by issuing the

-U__MATHERR_ERRNO_DONTCAREmacro after the -fast option.

Inlining Standard Library Functions

Use the -xbuiltin[=%all|%none] command when you want to improve the

optimization of code that calls standard library functions. Many standard library

functions, such as the ones defined in math.h and stdio.h , are commonly used by
10 What’s New in Sun WorkShop 6 update 1 • October 2000



various programs. This command lets the compiler substitute intrinsic pure

functions for system functions to improve performance. The -xbuiltin command

has the following syntax:

■ -xbuiltin=%all

■ -xbuiltin=%none

The first default of this command is -xbuiltin=%none , which means no functions

from the standard libraries are inlined. The first default applies when you do not

specify -xbuiltin .

The second default is -xbuiltin=%all , which means the compiler inlines standard

library functions as it determines the optimization benefit. The second default

applies when you specify -xbuiltin but do not provide an argument.

If you compile with the -fast option, then -xbuiltin is set to %all .

Enabling and Disabling Trigraph Recognition

The -xtrigraphs option determines whether the compiler recognizes trigraph

sequences as defined by the ISO/ANSI C standard.

By default, the compiler assumes -xtrigraphs=yes and recognizes all trigraph

sequences throughout the compilation unit.

If your source code has a literal string containing question marks (?) that the

compiler is interpreting as a trigraph sequence, you can use the -xtrigraph=no
suboption to turn off the recognition of trigraph sequences. The -xtrigraphs=no
option turns off recognition of all trigraphs throughout the entire compilation unit.

Consider the following example source file named trigraphs_demo.c .

#include <stdio.h>

int main ()
{

  (void) printf("(\?\?) in a string appears as (??)\n");

  return 0;
}

Chapter 1 New Features in Sun WorkShop 6 update 1 11



Here is the output if you compile this code with -xtrigraphs=yes .

Here is the output if you compile this code with -xtrigraphs=no .

For more information on using the -xtrigraphs option, see the cc (1) man page.

For information on trigraphs, see the C User’s Guide chapter about transitioning to

ANSI/ISO C.

Prefetch Latency Specifier

(SPARC platform) If you are running computationally intensive codes on large

multiprocessors, you might find it advantageous to use the new -xprefetch
suboption latx: factor. This suboption instructs the code generator to adjust the

default latency time between a prefetch and its associated load or store by the

specified factor.

For more information, see the cc (1) man page.

Overriding the Default Search Path With the -I-
Option

The new -I- option gives you more control over the algorithm that the compiler

uses when searching for include files. This section first describes the default search

algorithms, then it describes the effect of -I- on these algorithms.

Default Search Algorithm for Quote-Included Files

For statements of the form #include "foo.h" (where quotation marks are used),

the compiler searches for include files in the following order:

1. The current directory (that is, the directory containing the “including” file)

example% cc -xtrigraphs=yes trigraphs_demo.c
example% a.out
(??) in a string appears as (]

example% cc -xtrigraphs=no trigraphs_demo.c
example% a.out
(??) in a string appears as (??)
12 What’s New in Sun WorkShop 6 update 1 • October 2000



2. The directories named with -I options, if any

3. The /usr/include directory

Default Search Algorithm for Bracket-Included Files

For statements of the form #include <foo.h> (where angle brackets are used), the

compiler searches for include files in the following order:

1. The directories named with -I options, if any

2. The /usr/include directory

Using the -I- Option to Change the Search Algorithm

The new -I- option gives more control over the default search rules. When -I-
appears in the command line:

■ The compiler never searches the current directory, unless the directory is listed

explicitly in a -I directive. This effect applies even for include statements of the

form #include "foo.h" .

■ For include statements of the form #include "foo.h", the compiler searches

for include files in the following order:

a. The directories named with -I options (both before and after -I- )

b. The /usr/include directory

■ For include statements of the form #include <foo.h>, the compiler searches

for include files in the following order:

a. The directories named with -I that appear after -I- (that is, the compiler does

not search the -I directories that appear before -I- )

b. The /usr/include directory
Chapter 1 New Features in Sun WorkShop 6 update 1 13



The following example shows the results of using -I- when compiling prog.c .

The following command shows the default behavior of searching the current

directory (the directory of the including file) for include statements of the form

#include "foo.h" . When processing the #include "c.h" statement in inc/a.h ,

the preprocessor includes the c.h header file from the inc subdirectory. When

processing the #include "c.h" statement in prog.c , the preprocessor includes

the c.h file from the directory containing prog.c . Note that the -H option instructs

the compiler to print the paths of the included files.

prog.c #include "a.h"
#include <b.h>
#include "c.h"

c.h #ifndef _C_H_1
#define _C_H_1
int c1;
#endif

int/a.h #ifndef _A_H
#define _A_H
#include "c.h"
int a;
#endif

int/b.h #ifndef _B_H
#define _B_H
#include <c.h>
int b;
#endif

int/c.h #ifndef _C_H_2
#define _C_H_2
int c2;
#endif

example% cc -c -Iinc -H prog.c
inc/a.h

inc/c.h
inc/b.h

inc/c.h
c.h
14 What’s New in Sun WorkShop 6 update 1 • October 2000



The next command shows the effect of the -I- option. The preprocessor does not

look in the including directory first when it processes statements of the form

#include "foo.h" . Instead, it searches the directories named by the -I options in

the order that they appear in the command line. When processing the #include
"c.h" statement in inc/a.h , the preprocessor includes the ./c.h header file

instead of the inc/c.h header file.

For more information, see the entry for -I- in the cc (1) man page.

C++ Compiler
TABLE 1-2 lists the new features available with the Sun WorkShop 6 update 1 release

of the C++ compiler (5.2). Some of the features are described in greater detail in the

sections following the table.

example% cc -c -I. -I- -Iinc -H prog.c
inc/a.h

./c.h
inc/b.h

inc/c.h
./c.h

TABLE 1-2 C++ Compiler New Features

Feature Options Description

Support for the

UltraSPARC III

Processor

-xtarget
-xchip

The -xtarget and -xchip
options now accept ultra3 .

See the following discussion

for the recommended flags to

use for optimal UltraSPARC III

performance.

Compile-Time

Performance

The compiler is substantially

faster for many large programs,

particularly those that use

templates heavily.
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Lifetime of

Temporary Objects

-features=tmplife (Standard mode only) A new

-features=tmplife
suboption instructs the

compiler to destroy temporary

objects according to the

requirements of the C++

standard.

Overriding the

Default Search Path

With the -I- Option

-I- The new -I- option gives you

more control over the

algorithm that the compiler

uses when searching for

include files.

Interval Arithmetic

Support for C++

-xia
-library=[no%]interval

(SPARC platform) This release

of the C++ compiler provides a

C++ interface to the interval

arithmetic library.

Mixed-Language

Linking

-xlang
-staticlib

The new -xlang option

enables linking of mixed

Fortran and C++ object files.

Enabling and

Disabling Trigraph

Recognition

-xtrigraphs The new -xtrigraphs option

enables and disables trigraph

translation.

Filtering Linker Error

Messages

-filt The new -filt option allows

you to customize the filtering

of linker error messages. For

example, you can request

mangled names.

Shared libCstd A shared version of libCstd
is available in the lib
directory of the C++ compiler.

Shared libiostream A shared version of

libiostream is available in

the lib directory of the C++

compiler.

Optimization

Pragmas

The C++ compiler recognizes

the new optimization pragmas

no_side_effects and

returns_new_memory .

TABLE 1-2 C++ Compiler New Features (Continued)

Feature Options Description
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Support for the UltraSPARC III Processor

Use the following options to compile for optimal performance when compiling and

running your program on an UltraSPARC III processor:

-fast -xcrossfile -xprofile={collect:|use:}

■ For cross-compilation (compiling on a platform other than UltraSPARC III but

generating object binaries to run on an UltraSPARC III system), add the following

options to insure correct cache sizes and optimization strategies:

-xtarget=ultra3 -xarch={v8plusb|v9b}

■ Specify -xarch=v8plusb for 32-bit code generation and v9b for 64-bit code.

-xarch=v9b should only be used when 64-bit code generation is required. In

some cases it can result in slower performance.

■ The -fast option enables optimizations that favor speed of execution and raises

the optimization level to -xO5 . Note that -fast allows substitution of faster

arithmetic operations where possible (-fsimple=2 ), so some inaccuracies might

result.

■ -xcrossfile enables the compiler to apply optimizations across all the source

files specified on the command line, including some interprocedural

optimizations.

■ -xprofile={collect:|use:} enables program performance profiling.

Profiling allows the compiler to identify the most frequently executed sections of

code and to perform localized optimizations to best advantage.

Note – Programs compiled specifically for the UltraSPARC III platform with

-xarch={v8plusb|v9b} will not operate on platforms other than the

UltraSPARC III platform. Use -xarch={v8plusa|v9a} to compile programs to run

compatibly on UltraSPARC I, UltraSPARC II, and UltraSPARC III platforms.

Recognition of .c++
Extension

The C++ compiler now

recognizes .c++ as a valid

filename suffix.

Prefetch Latency

Specifier

-xprefetch= ...,latx: factor This new suboption determines

how far apart the instruction

the compiler generates to

prefetch data will be from the

subsequent use of the data in a

load or store instruction.

TABLE 1-2 C++ Compiler New Features (Continued)

Feature Options Description
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Lifetime of Temporary Objects

When the compiler evaluates expressions, it sometimes creates temporary objects.

For example, the compiler may create a temporary object when a function is called

or when a cast creates a class object. The old language definition allowed such

temporary objects to be destroyed at any time up until the end of the block in which

the temporary object was created. The C++ standard specifies that the compiler must

destroy a temporary object at the end of the full expression in which the object is

created, unless the object is used to initialize a reference.

By default, the C++ compiler (5.2) implements the old language definition; it

destroys temporary objects at the end of the block in which they are created. To

make the compiler destroy temporary objects according to the requirements of the

C++ standard, use the new -features=tmplife suboption.

For example, consider the following block.

If you specify -features=tmplife in the command line, the call sequence is as

shown here.

If you do not specify the -features=tmplife suboption, the call sequence is as

shown here.

This suboption is not available in compatibility mode (-compat[=4] ).

{  foo(ClassA()); bar(ClassB()); some-statement; }

tmp1=ClassA(); foo(tmp1); tmp1.~ClassA();
tmp2=ClassB(); bar(tmp2); tmp2.~ClassB();
some-statement;

tmp1=ClassA(); foo(tmp1);
tmp2=ClassB(); bar(tmp2);
some-statement;
tmp2.~ClassB();
tmp1.~ClassA();
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Overriding the Default Search Path With the -I-
Option

The new -I- option gives you more control over the algorithm that the compiler

uses when searching for include files. This section first describes the default search

algorithms, then it describes the effect of -I- on these algorithms.

Default Search Algorithm for Quote-Included Files

For statements of the form #include "foo.h" (where quotation marks are used),

the compiler searches for include files in the following order:

1. The current directory (that is, the directory containing the “including” file)

2. The directories named with -I options, if any

3. The directories for compiler-provided C++ header files, ANSI C header files, and

special-purpose files

4. The /usr/include directory

Default Search Algorithm for Bracket-Included Files

For statements of the form #include <foo.h> (where angle brackets are used), the

compiler searches for include files in the following order:

1. The directories named with -I options, if any

2. The directories for compiler-provided C++ header files, ANSI C header files, and

special-purpose files

3. The /usr/include directory

Note – If the name of the include file matches the name of a standard header, also

refer to Section 5.7.4 Standard Header Implementation in the C++ User’s Guide.

Using the -I- Option to Change the Search Algorithm

The new -I- option gives more control over the default search rules. When -I-
appears in the command line:
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■ The compiler never searches the current directory, unless the directory is listed

explicitly in a -I directive. This effect applies even for include statements of the

form #include "foo.h" .

■ For include statements of the form #include "foo.h", the compiler searches

for include files in the following order:

a. The directories named with -I options (both before and after -I- )

b. The directories for compiler-provided C++ header files, ANSI C header files,

and special-purpose files

c. The /usr/include directory

■ For include statements of the form #include <foo.h>, the compiler searches

for include files in the following order:

a. The directories named with -I options that appear after -I- (that is, the

compiler does not search the -I directories that appear before -I- )

b. The directories for compiler-provided C++ header files, ANSI C header files,

and special-purpose files

c. The /usr/include directory

The following example shows the results of using -I- when compiling prog.cc .

prog.cc #include "a.h"
#include <b.h>
#include "c.h"

c.h #ifndef _C_H_1
#define _C_H_1
int c1;
#endif
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The following command shows the default behavior of searching the current

directory (the directory of the including file) for include statements of the form

#include "foo.h" . When processing the #include "c.h" statement in inc/a.h ,

the compiler includes the c.h header file from the inc subdirectory. When

processing the #include "c.h" statement in prog.cc , the compiler includes the

c.h file from the directory containing prog.cc . Note that the -H option instructs

the compiler to print the paths of the included files.

The next command shows the effect of the -I- option. The compiler does not look in

the including directory first when it processes statements of the form #include
"foo.h" . Instead, it searches the directories named by the -I options in the order

inc/a.h #ifndef _A_H
#define _A_H
#include "c.h"
int a;
#endif

inc/b.h #ifndef _B_H
#define _B_H
#include <c.h>
int b;
#endif

inc/c.h #ifndef _C_H_2
#define _C_H_2
int c2;
#endif

example% CC -c -Iinc -H prog.cc
inc/a.h

inc/c.h
inc/b.h

inc/c.h
c.h
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that they appear in the command line. When processing the #include "c.h"
statement in inc/a.h , the compiler includes the ./c.h header file instead of the

inc/c.h header file.

For more information, see the entry for -I- in the CC(1) man page.

Interval Arithmetic Support for C++

(SPARC platform) Sun WorkShop™ 6 update 1 Compilers C++ (5.2) provides a C++

interface to the C++ interval arithmetic library. For more information, see “Interval

Arithmetic” on page 31 in this document and the C++ Interval Arithmetic
Programming Reference available from http://docs.sun.com (in the Forte™

Developer 6 update 1/Sun WorkShop 6 update 1 Collection).

For information about related compiler options, see the entries for the following in

the CC(1) man page:

■ -xia

■ -library=[no%]interval

Note – The C++ interval arithmetic library is compatible with interval arithmetic as

implemented in the Fortran compiler.

Mixed-Language Linking

The new -xlang option allows you to link Fortran and C++ object files. For

example, you can link a C++ main program with Fortran object files.

To determine which driver to use for mixed-language linking, use the following

language hierarchy:

1. C++

2. Fortran 95 (or Fortran 90)

example% CC -c -I. -I- -Iinc -H prog.cc
inc/a.h

./c.h
inc/b.h

inc/c.h
./c.h
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3. Fortran 77

When linking Fortran 95, Fortran 77, and C++ object files together, use the driver of

the highest language. For example, use the following C++ compiler command to link

C++ and Fortran 95 object files.

To link Fortran 95 and Fortran 77 object files, use the Fortran 95 driver, as follows.

For more information, see the entries for the following in the CC(1) man page:

■ -xlang=f77,f90,f95

■ -staticlib=[no%]f77,[no%]f90,[no%]f95,[no%]sunperf

Enabling and Disabling Trigraph Recognition

The -xtrigraphs option determines whether the compiler recognizes trigraph

sequences as defined by the ISO/ANSI C standard.

By default, the compiler assumes -xtrigraphs=yes and recognizes all trigraph

sequences throughout the compilation unit.

If your source code has a literal string containing question marks (?) that the

compiler is interpreting as a trigraph sequence, you can use the -xtrigraph=no
suboption to turn off the recognition of trigraph sequences. The -xtrigraphs=no
option turns off recognition of all trigraphs throughout the entire compilation unit.

Consider the following example source file named trigraphs_demo.cc .

example% CC -xlang=f95  ...

example% f95 -xlang=f77  ...

#include <stdio.h>

int main ()
{

  (void) printf("(\?\?) in a string appears as (??)\n");

  return 0;
}
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Here is the output if you compile this code with -xtrigraphs=yes .

Here is the output if you compile this code with -xtrigraphs=no .

For more information on using the -xtrigraphs option, see the CC(1) man page.

For information on trigraphs, see the C User’s Guide chapter about transitioning to

ANSI/ISO C.

Filtering Linker Error Messages

The new -filt option controls the filtering that CCnormally applies to linker error

messages.

■ -filt=no%names suppresses the demangling of C++ mangled linker names.

■ -filt=no%returns suppresses the demangling of return types of functions.

This suppression helps you identify function names more quickly, but note that in

the case of co-variant returns, some functions differ only in the return type.

■ -filt=no%errors suppress the C++ explanation of linker error messages. This

suppression is useful when the linker diagnostics are provided directly to another

tool.

example% CC -xtrigraphs=yes trigraphs_demo.cc
example% a.out
(??) in a string appears as (]

example% CC -xtrigraphs=no trigraphs_demo.cc
example% a.out
(??) in a string appears as (??)
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The following example shows the effects of using -filt when compiling this code.

When you compile the code without the -filt option, the compiler assumes

-filt=names,returns,errors and displays the standard output.

The following command suppresses the demangling of the of the C++ mangled

linker names and suppresses the C++ explanations of linker errors.

For more information, see the CC(1) man page.

// filt_demo.cc
class type {
public:
    virtual ~type(); // no definition provided
};

int main()
{
    type t;
}

example% CC filt_demo.cc
Undefined first referenced
 symbol in file
type::~type() filt_demo.o
type::__vtbl filt_demo.o
[Hint: try checking whether the first non-inlined, non-pure
virtual function of class type is defined]

ld: fatal: Symbol referencing errors. No output written to a.out

example% CC -filt=no%names,no%errors filt_demo.cc
Undefined                       first referenced
 symbol                             in file
__1cEtype2T6M_v_                    filt_demo.o
__1cEtypeG__vtbl_                   filt_demo.o
ld: fatal: Symbol referencing errors. No output written to a.out
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Shared libCstd

Sun WorkShop 6 update 1 Compilers C++ (5.2) includes a shared version of the

libCstd library.

To use the shared version of libCstd , compile the program in the usual way, but

use a separate link step. In the link step, use the -library=no%Cstd option, and

put the shared library name explicitly on the command line, as shown in this

example.

If Sun WorkShop 6 update 1 is not installed in /opt , ask your system administrator

for the equivalent path.

Note – If you use -library=no%Cstd in a command that compiles any C++ source

code, the compiler will not find C++ standard headers.

Shared libiostream

Sun WorkShop 6 update 1 Compilers C++ (5.2) includes a shared version of the

classic iostream library, libiostream .

To use the shared version of libiostream , compile the program in the usual way,

but use a separate link step. In the link step, put the shared library name explicitly

on the command line, and do not use the -library=iostream option, as shown in

this example.

If Sun WorkShop 6 update 1 is not installed in /opt , ask your system administrator

for the equivalent path.

Note – You must use -library=iostream on each compilation of the program

build, but you must not use -library=iostream on the link step.

example% CC -library=no%Cstd *.o \
-o myprog /opt/SUNWspro/WS6U1/lib/libCstd.so.1

example% CC *.o -o myprog \
/opt/SUNWspro/WS6U1/lib/lib/libiostream.so.1
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Optimization Pragmas

To help the optimizer generate better code, you can use the following new pragmas:

■ #pragma no_side_effects ( name . . .)

Use this pragma to indicate that the function does not change any persistent state.

■ #pragma returns_new_memory ( name, . . .)

Use this pragma when the function returns the address of the newly allocated

memory and you can guarantee that the pointer does not alias with any other

pointer.

For both pragmas, name refers to the most recently declared function that uses that

name.

Place these pragmas immediately after the functions to which they refer. For

example, the first code example shows the correct placement of the

no_side_effects pragma and the second example shows an incorrect placement.

Recognition of .c++ Extension

When a file name appears on the command line, the compiler looks at the suffix to

determine how to process the file. For example, the compiler processes files ending

with .o as object files. The Sun WorkShop 6 update 1 Compilers C++ (5.2)

recognizes files with the following extensions as C++ source files.

■ .c

■ .C

■ .cc

■ .cpp

■ .cxx

■ .c++

■ .i

class good_example {
void no_op();
#pragma no_side_effects (no_op) // correct placement

}

class bad_example{
void no_op();

}
#pragma no_side_effects (no_op) // incorrect placement
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Prefetch Latency Specifier

(SPARC platform) If you are running computationally intensive codes on large

multiprocessors, you might find it advantageous to use the new -xprefetch
suboption latx: factor. This suboption instructs the code generator to adjust the

default latency time between a prefetch and its associated load or store by the

specified factor.

For more information, see the CC(1) man page.

Fortran Compilers
Both the Fortran 95 and Fortran 77 compilers are released with Sun WorkShop 6

update 1.

TABLE 1-3 lists the new features available with the Sun WorkShop 6 update 1 release

that are common to both the Fortran 95 and Fortran 77 compilers. Some of the

features are described in greater detail in the sections following the table.

TABLE 1-3 Fortran Compilers New Features

Feature Options Description

Support for the

UltraSPARC III

Processor

-xtarget
-xchip

The -xtarget and -xchip options

now accept ultra3 . See the following

discussion for the recommended flags

to use for optimal UltraSPARC III

performance.

Support for int2
Intrinsic

The int2 intrinsic supports

compatibility with older Fortran 77

programs. It is equivalent to the

preferred Fortran 95 int( var,2)
intrinsic for conversion of data

argument var to a 2-byte integer.
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Support for the UltraSPARC III Processor

Use the following options to compile for optimal performance when compiling and

running your program on an UltraSPARC III processor:

-fast -xcrossfile -xprofile={collect:|use:}

■ For cross-compilation (compiling on a platform other than UltraSPARC III but

generating object binaries to run on an UltraSPARC III system), add the following

options to insure correct cache sizes and optimization strategies:

-xtarget=ultra3 -xarch={v8plusb|v9b}

■ Specify -xarch=v8plusb for 32-bit code generation and v9b for 64-bit code. For

programs accessing very large data files, 64-bit code provides better performance.

However, -xarch=v9b should only be used when 64-bit code generation is

required. In some cases it can result in slower performance.

■ The -fast option enables optimizations that favor speed of execution and raises

the optimization level to -xO5 . Note that -fast allows substitution of faster

arithmetic operations where possible (-fsimple=2 ), so some inaccuracies might

result.

■ -xcrossfile enables the compiler to apply optimizations across all the source

files specified on the command line, including some interprocedural

optimizations.

■ -xprofile={collect:|use:} enables program performance profiling.

Profiling allows the compiler to identify the most frequently executed sections of

code and to perform localized optimizations to best advantage.

Enhanced -fast
Option

-fast The -fast option now includes the

-xprefetch option.

Prefetch Latency

Specifier

-xprefetch= ...,latx: factor This new suboption determines how

far apart the instruction the compiler

generates to prefetch data will be from

the subsequent use of the data in a

load or store instruction.

Mixed-Language

Linking

-xlang The new -xlang option enables

linking of mixed Fortran and C++

object files.

TABLE 1-3 Fortran Compilers New Features (Continued)

Feature Options Description
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Note – Programs compiled specifically for the UltraSPARC III platform with

-xarch={v8plusb|v9b} will not operate on platforms other than the

UltraSPARC III platform. Use -xarch={v8plusa|v9a} to compile programs to run

compatibly on UltraSPARC I, UltraSPARC II, and UltraSPARC III platforms.

Support for int2 Intrinsic

The Fortran 95 and Fortran 77 compilers now support the int2 intrinsic for

conversion of data types to 2-byte integer. Use of int2 as an intrinsic appears in

many legacy Fortran 77 codes in the form M=int2(J) .

The preferred Fortran 95 usage is M=int(J,2) .

Enhanced -fast Option

The -xprefetch option has been added to the list of options included in the -fast
option. This enables the compiler to strategically generate prefetch instructions.

Using the -xprefetch option can add a substantial performance gain in code with

loops that process data. The prefetch mechanism of the UltraSPARC III platform is

much improved over that used by the UltraSPARC II platform.

Prefetch Latency Specifier

(SPARC platform) If you are running computationally intensive codes on large

multiprocessors, you might find it advantageous to use the new -xprefetch
suboption latx: factor. This suboption instructs the code generator to adjust the

default latency time between a prefetch and its associated load or store by the

specified factor.

See the f77 (1) and f95 (1) man pages for details.

Mixed-Language Linking

The new -xlang option allows you to link Fortran and C++ object files. For

example, you can link a Fortran main program with C++ object files.
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To determine which driver to use for mixed-language linking, use the following

language hierarchy:

1. C++

2. Fortran 95

3. Fortran 77

When linking Fortran 95, Fortran 77, and C++ object files together, use the driver of

the highest language. For example, use the following C++ compiler command to link

C++ and Fortran 95 object files.

To link Fortran 95 and Fortran 77 object files, use the Fortran 95 driver, as follows.

Interval Arithmetic
TABLE 1-4 lists the new features available with the Sun WorkShop 6 update 1 release

of interval arithmetic.

example% CC -xlang=f95  ...

example% f95 -xlang=f77  ...

TABLE 1-4 Interval Arithmetic New Features

Feature Description

Interval Arithmetic Support

for C++

(SPARC platform) This release of the C++ compiler provides

a C++ interface to the interval arithmetic library.

New f95 INTERVAL
Intrinsic Operators and

Functions

f95 interval arithmetic adds support for the dependent

subtraction operator, a division with intersection function,

and the interval version of the generic random number

generation subroutine RANDOM_NUMBER.
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Interval Arithmetic Support for C++

The Sun WorkShop 6 update 1 release includes a C++ version of the interval

functions and operators that are contained in Fortran 95 Interval Arithmetic. For

more information about the C++ interval arithmetic library, see the C++ Interval
Arithmetic Programming Reference available from http://docs.sun.com (in the

Forte™ Developer 6 update 1/Sun WorkShop 6 update 1 Collection).

Interval Arithmetic support for C++ provides a C++ header file and library that

implements three interval classes, one each for float, double, and long double. The

interval classes include:

■ Interval arithmetic operations and mathematical functions that form a closed

mathematical system, which means that valid results are produced for any

possible operator-operand combination, including division by zero and other

indeterminate forms involving zero and infinities

■ Three types of interval relational functions:

■ Certainly

■ Possibly

■ Set

■ Interval-specific functions, such as intersect and interval_hull

■ Interval-specific functions, such as inf , sup , and wid

■ Interval input/output, including single-number input/output

For standard mode compilation, all symbols in the library are in the namespace

SUNW_interval .

The compilation interface consists of the following:

■ A new value, interval , for the -library flag, which expands to the

appropriate libraries.

■ A new value, interval , for the -staticlib flag, which at present is ignored

because only static libraries are provided with this release.

■ A new flag, -xia , which is the same flag used with the Fortran compilers,

although the expansion is different.

To use the C++ interval arithmetic features, add the following header file to the

code.

#include <suninterval.h>
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An example of compiling code using the -xia command-line option is shown

below.

New f95 INTERVAL Intrinsic Operators and

Functions

The following features have been added to f95 interval arithmetic:

■ Dependent Subtraction Operator

■ Division With Intersection Function

■ Random Number Subroutine

Dependent Subtraction Operator

The dependent subtraction operator .DSUB. can be used to recover either operand

of an interval arithmetic addition.

Two interval variables are dependent when one interval variable is a result of an

interval arithmetic operation applied to the other interval variable. For example, if

X = A + B, then X depends on both A and B. Dependent interval subtraction

produces narrower interval results when recovering A or B from X.

Note – Dependent operations cannot be applied to interval constants because

constants are independent. Applying dependent operations to interval constants

produces a compile-time error.

The result of X.DSUB.A contains the solution for B of the interval equation

X = A + B. The result is [-inf,inf] if there is no solution.

■ Arguments. X and A must be intervals with the same kind type parameter value.

■ Result type. Same as X.

The following examples show the behavior of DSUB.

■ X .DSUB. X = [0] if

■ X .DSUB. A = [-inf,inf] if WID(X) < WID(A) because WID(X) must be greater

than or equal to WID(A) if X = A + B.

■ [empty] .DSUB. [empty] = [-inf,inf]

■ [empty] .DSUB. A = [empty] if A ≠ [empty]

example% CC -o filename -xia filename.cc

∞– x x +∞<≤<
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■ X .DSUB. [empty] = [-inf,inf] if X ≠ [empty] . This result follows because

X ≠ [empty] and A ≠ [empty] is an impossible combination.

Division With Intersection Function

The function DIVIX returns C ∩ (B/A), the interval enclosure of the result of the

interval division operation (B/A) intersected with the interval C.

In the case when A contains zero, the mathematical result of the interval division

operation (B/A) is the union of two disjoint intervals. Each interval in the union can

be represented in the currently implemented interval arithmetic system. The DIVIX
function allows one or part of these intervals to be returned.

■ Arguments. A, B, and C must be intervals with the same kind type parameter

value.

■ Result type. Same as A.

The following example shows the output of DIVIX .

Random Number Subroutine

RANDOM_NUMBER(HARVEST)returns through the interval variable HARVESTone

pseudorandom interval or an array of pseudorandom intervals .

0 ≤ ≤ < 1 holds for the interval endpoints, where is the lower endpoint, and is

the upper endpoint. Therefore, is uniformly distributed on the interval [0, 1], and,

given , is uniformly distributed on the interval .

DIVIX( [3.0,5.0] , [6.0,15.0] , [2.0,6.0] )== [2.0,5.0]
DIVIX( [-3.0,5.0] , [8.0,20.0] , [-0.5,1.0] )== [EMPTY]
DIVIX( [-3.0,5.0] , [8.0,20.0] , [-7.0,8.0] )== [-7.0,8.0]
DIVIX ([-1,1], [1], [-Inf,0.0E+0]) == [-Inf,-1.0]
DIVIX ([-1,1], [1], [0,inf])       == [1.0,Inf]

x x,[ ]

x x x x
x

x x x 1,[ ]
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dbx
TABLE 1-5 lists the new features available with the Sun WorkShop 6 update 1 release

of dbx .

Sun Performance Library

Sun Performance Library™ is a set of optimized, high-speed mathematical

subroutines for solving linear algebra and other numerically intensive problems.

Sun Performance Library is based on a collection of public domain applications

available from Netlib at http://www.netlib.org . These routines have been

enhanced and bundled as the Sun Performance Library.

TABLE 1-6 lists the new features and enhancements available with the

Sun WorkShop 6 update 1 release of the Sun Performance Library.

TABLE 1-5 dbx New Features

Feature Description

Support for Interval

Arithmetic Expressions in

Fortran

Fortran interval types and expressions are now supported.

Simple arithmetic (add, subtract, multiply, divide, negate),

equal, and not equal operations are implemented.

TABLE 1-6 Sun Performance Library New Features

Feature Description

Additional Performance

Enhancements for the

UltraSPARC III Processor

Optimized performance on both single-processor and multi-

processor UltraSPARC III platforms.

Fast Fourier Transform (FFT)

Improvements

Made changes to man pages, added additional error-checking

to the code, and made performance improvements.

FFT Documentation Created Using Sun Performance Library Fast Fourier Transform
Routines document that describes FFTPACKand VFFTPACK
routines. Using Sun Performance Library Fast Fourier Transform
Routines is available from http://docs.sun.com
in the Forte™ Developer 6 update 1/Sun WorkShop 6

update 1 Collection.
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Sampling Analyzer
TABLE 1-7 lists the new features available with the Sun WorkShop 6 update 1 release

of the Sampling Analyzer.

Sparse Solver Improved performance and functionality, extend messaging

system, incorporated SuperLU.

Improved Parallelization and

Scalability

Used data flow programming techniques on selected routines

and libraries to improve performance.

Open MP Directives Used Increased support for Open MP directives.

Interval Matrix-Multiply

Implemented

Developed an interval-based MATMULfor the f95 intrinsics,

which is the non-transpose, non-transpose case of the GEMM
and GEMVroutines.

TABLE 1-7 Sampling Analyzer New Features

Feature Description

Hardware Counter Overflow

Profiling

Hardware counter overflow profiling records the callstack of

each light-weight process (LWP) at the time the hardware

counter of the CPU on which the LWP is running overflows.

Standalone collect
Command

The new collect command allows you to collect

performance data on your applications independent of

Sun WorkShop and dbx .

Improved Support for MPI

Applications

The new collect command provides improved message-

passing interface (MPI) support.

Improved Support for

OpenMP (libmtsk )

Applications

You can now distinguish when a slave thread is waiting for

synchronization at the end of a parallel region and when it is

waiting because the code is in a serial region.

Improved Mapfile Generation The mapfile is now produced so that it orders the executable

by whatever metric is being used for sorting the function list.

Additions to the Select Filters

Dialog Box

The Experiment list and Select All, Clear All, and Reverse

buttons in the Select Filters dialog box let you select

experiments for which you want to change the data

displayed. The Enable All, Enable All Selected, Disable All,

and Disable All Selected buttons let you enable and disable

data display for experiments.

TABLE 1-6 Sun Performance Library New Features (Continued)

Feature Description
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Hardware Counter Overflow Profiling

Hardware counter overflow profiling records the callstack of each light-weight

process (LWP) at the time the hardware counter of the CPU on which the LWP is

running overflows. The data recorded includes a timestamp and the IDs of the CPU,

the thread, and the LWP. Hardware counter overflow profiling can be done only on

UltraSPARC III systems running the Solaris 8 Operating Environment SPARC
Platform Edition and on Intel systems (Pentium II or III) running the Solaris 8

Operating Environment Intel Platform Edition. For more information, see “Hardware

Counter Overflow Profiling Data” and “Choosing the Data to Collect” in the Using

the Debugging Window section of the Sun WorkShop online help.

Standalone collect Command

The new collect command allows you to collect performance data on your

applications independent of Sun WorkShop and dbx . It provides arguments for

specifying the types of data to be collected, naming experiments and experiment

groups, and requesting that the target process be left stopped on the exit from the

exec system call, in order to allow a debugger to attach to it. For more information,

see the collect (1) man page.

Improved Support for MPI Applications

The new collect command provides the following improved message-passing

interface (MPI) support:

■ The collect command lets you specify experiment groups, which allows

experiments from all the processes of an MPI run to be grouped and processed

together.

■ Synchronization delay tracing records all calls to the various thread

synchronization routines where the real-time delay in the call exceeds a specified

threshold.
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CHAPTER 2

New Features in Sun WorkShop 6

This chapter describes the new features of the Sun WorkShop™ 6 compilers and

tools. Tables summarize new features, and explanations of some of the new features

follow the summary tables.

This chapter has the following sections:

■ “C Compiler” on page 40

■ “C++ Compiler” on page 41

■ “Fortran Compilers” on page 48

■ “Fortran 95 Interval Arithmetic” on page 53

■ “dbx ” on page 54

■ “Sun WorkShop 6” on page 56

■ “Sun WorkShop TeamWare 6” on page 64

■ “Sun WorkShop Visual 6” on page 67

■ “Sun Performance Library” on page 69

■ “Sampling Analyzer” on page 71

■ “Installation” on page 75

■ “Documentation in HTML” on page 75

Key Features

The following key features are the highlights of this release:

■ Additional ANSI/ISO C++ compliance

■ Fortran 95 compiler with OpenMP parallelization directives

■ Support for the UltraSPARC™ III instruction set architecture

■ Easier-to-use programming environment

■ New Performance Analysis tool

■ Fortran 95 interval arithmetic

■ Installation improvements

■ Manuals, man pages, readmes, and online help in HTML
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C Compiler

TABLE 2-1 lists the new features available with the release of the Sun WorkShop 6 C

compiler. These features enhance the capabilities of the C compiler and lint source-

code checker.

TABLE 2-1 C Compiler New Features

Feature Description

_ _func_ _ The C compiler predefines a static, constant, char array

named_ _func_ _ for every function definition. The array is

initialized with the name of the function and can be used

anywhere a static function scope array can be used, such as

when printing the name of the enclosing function.

Variable argument macro The C preprocessor accepts a variable number of arguments

for a #define macro. If the macro definition includes an

ellipsis as part of the identifier list, then there will be more

arguments when the macro is invoked than there were

parameters in the macro definition.

SUNW_MP_THR_IDLE You can use the SUNW_MP_THR_IDLEenvironment variable

to control whether a thread continues to use system

resources after it finishes its task or it “sleeps.”

large arrays The C compiler supports significantly larger array objects.

For specifics, see Appendix A of the C User’s Guide.

-errchk=locfmtchk lint accepts a new flag, -errchk=locfmtchk , which

checks for printf -like format strings during the first pass

of lint .

new lint directive

(PRINTFLIKE( n))
lint accepts a new directive that identifies all calls to the

printf() family through a pointer. All such calls through

the pointer can be checked for argument consistency by

lint .

-errwarn=t The C compiler and the lint source code checker support a

new option, -errwarn=t , which causes the compiler to exit

with a failure status if any of the specified warnings are

issued.

-errchk The -errchk option of lint has a new value signext,
which you can use in conjunction with the longptr64
option: -errchk=longptr64,signext . This new option

warns about sign extension in order to facilitate migration to

the 64-bit development environment.
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C++ Compiler

TABLE 2-2 lists the new features available with the release of the Sun WorkShop 6

C++ compiler. Some of these features are described more completely in the sections

following the table.

-xchar_byte_order The -xchar_byte_order option produces an integer

constant by placing the characters of a multi-character

character-constant in the specified byte order.

-xinline The -xinline option accepts two new values: %auto and

no%function_name. The %auto value takes effect at the -x04
level of optimization and allows the compiler to

automatically inline functions in addition to the listed

function for -xinline . The %no function_name value tells

the compiler to not inline the function function_name.

-xmemalign The C compiler offers a new option named -xmemalign .

This option controls code generated for potentially

misaligned memory accesses and controls program behavior

in the event of a misaligned access.

-xprefetch You can use the sun_prefetch.h header file and the

-xprefetch option to specify explicit prefetch instructions.

-xvector The -xvector option enables automatic generation of calls

to the vector library functions.

TABLE 2-2 C++ Compiler New Features

Feature Description

Partial Specialization A template can be partially specialized, meaning that only

some of the template parameters are specified or that one or

more parameters are limited to certain categories of type.

Explicit Function Template

Argument

If a template argument cannot be deduced from the function

arguments, you can specify it explicitly using the syntax

f <template args>( function args) .

Non-Type Function

Template Parameters

This release supports non-type function template parameters,

such as:

template<int I> void foo( int a[I] ) { ... }
template<int I> void foo( mytype<I> m ) { ... }

TABLE 2-1 C Compiler New Features (Continued)

Feature Description
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Member Templates In standard mode, classes and class templates can have

templates as members.

Definitions-Separate

Template Organization

Restriction Removed

The compiler no longer has a restriction against “definitions-

separate template organization” for -instances != extern
(that is, -instances=explicit , -instances=global ,

-instances=semiexplicit, or -instances=static ).

Regardless of the -instances setting, by default the

compiler now includes separate source files in the search for

definitions.

Prefetch Instructions You can use -xprefetch in conjunction with the header file

<sun_prefetch.h> to specify prefetch instructions on those

architectures that support prefetch, such as the UltraSPARC II

instruction set architecture (-xarch=v8plus , v8plusa ,

v8plusb , v9 , v9a , or v9b ).

Extern Inline Functions This version of the compiler allows extern inline functions. If

there is any local static data in an inline function, only one

copy of the static data is used in all compilation units.

However, the addresses of inline functions taken in different

translation units will not compare as equal.

Ordering of Static Variable

Destruction

The standard has defined the order of destruction of objects

with static storage duration more fully; static objects must be

destroyed in the reverse order of their construction. Previous

language definitions left some aspects unspecified.

Sub-Aggregate

Initialization

When using brace-initialization of class objects (for types

where brace-initialization is allowed), the C++ standard

permits a member which is itself an aggregate class to be

initialized by a value of its own type.

Using Your Own C++

Standard Library

By specifying the -library=no%Cstd option, you can use

your own version of the C++ standard library, instead of the

version supplied with the compiler.

Cache Versioning The C++ compiler has the ability to detect cache version

differences and issue the appropriate error message.

Restrictions on Bitfield

Size Removed

The restriction on the size of a bitfield to 32 or less is removed.

Bitfields can be any size.

TABLE 2-2 C++ Compiler New Features (Continued)

Feature Description
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Partial Specialization

A template can be fully specialized, meaning that an implementation is defined for

specific template arguments. See the following code example.

A template can also be partially specialized, meaning that only some of the template

parameters are specified, or that one or more parameters are limited to certain

categories of type. The resulting partial specialization is itself still a template. The

following examples use the previous primary template.

■ Special template definition for cases when the first template parameter is type

int . See the following code example.

Warnings About

Conversions Between

Pointer-To-Function and

void*

Previously, the compiler issued warnings about conversions

between pointer-to-function and void* . The compiler only

issues these warnings when you use the +w2 option.

New and Changed

Options

The following list shows the new and changed options.

• New Options:

-xcrossfile
-Bsymbolic
-features=[no%]strictdestrorder
-template=extdef .

• Changed Options:

-fast
-library=[no%]Cstd , +p
-ptr , -xprefetch
For more information, see the entry for each option in the C++
User’s Guide. To access this guide in HTML, point your

browser to file:/opt/SUNWspro/docs/index.html .

template<class T, class U> class A { ... }; //primary template
template<> class A<int, double> { ... }; //specialization

template<classU> class A<int> { ... };

TABLE 2-2 C++ Compiler New Features (Continued)

Feature Description
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■ Special template definition for cases when the first template parameter is any

pointer type. See the following code example.

■ Special template definition for cases when the first template parameter is pointer-

to-pointer of any type, and the second template parameter is type char . See the

following code example.

Explicit Function Template Argument

If a template argument cannot be determined from the function arguments, you can

now explicitly specify the template argument using the syntax

f< template args>( function args) . See the following code example.

Non-Type Function Template Parameters

This release supports non-type function template parameters, as illustrated in the

following code example.

This release does not allow expressions involving non-type template parameters in

the function parameter list, as illustrated in the following code example.

template<class T, class U> class A<T*> { ... };

template<class T> class A<T**, char> { ... };

template<class Mytype> Mytype* construct(float, float);
...
int* x = construct<int>(a, b);

template<int I> void foo( int a[I] ) { ... }
template<int I> void foo( mytype<I> m ) { ... }

// these are not supported
template<int I> void foo( mytype<2*I> ) { ... }
template<int I, int J> void foo( int a[I+J] ) { ... }
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Member Templates

In standard mode, classes and class templates can have templates as members, as

illustrated in the following code example.

Note – Member templates are not supported in compatibility mode

(-compat[=4] ).

Definitions-Separate Template Organization

Restriction Removed

The compiler no longer has a restriction against “definitions-separate template

organization” for -instances != extern (that is, -instances=explicit ,

-instances=global , -instances=semiexplicit or -instances=static) .

Regardless of the -instances setting, the compiler will now, by default, include

separate source files in the search for definitions.

To turn this restriction back on, use the -template=no%extdef option. Note,

however, that when the -template=no%extdef option is specified, the compiler

does not search for separate source files even with -instances=extern .

Ordering of Static Variable Destruction

The standard has defined the order of destruction of objects with static storage

duration more fully; static objects must be destroyed in the reverse order of their

construction. Previous language definitions left some aspects unspecified.

 template <class T1>
 class OuterClass {
 public:
     // class member template
     template <class T2>
         class MemberClass
     {
         T2 MCmember;
         T1 OCmember;
     };
     template<class T3> operator T3() { ... }
 ...
 };
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This stricter ordering is implemented for standard mode only. In compatibility mode

(-compat[=4] ), the order of destruction is implemented as before.

If your program depends on a particular order of destruction and worked with an

older compiler, the order required by the standard might break the program in

standard mode. The -features=no%strictdestrorder command option

disables the strict ordering of destruction.

Sub-Aggregate Initialization

When using brace-initialization of class objects (for types where brace-initialization

is allowed), the C++ standard permits a member that is itself an aggregate class to be

initialized by a value of its own type. See the following code example.

Using Your Own C++ Standard Library

If you want to use your own version of the C++ standard library instead of the

version supplied with the compiler, you can do so by specifying the

-library=no%Cstd option. This option prevents finding any of the following

headers:

<algorithm> <bitset> <complex> <deque> <fstream> <functional>
<iomanip> <ios> <iosfwd> <iostream> <istream> <iterator> <limits>
<list> <locale> <map> <memory> <numeric> <ostream> <queue> <set>
<sstream> <stack> <stdexcept> <streambuf> <string> <strstream>
<utility> <valarray> <vector>

struct S {  // an aggregate type
int i, j;
};
struct T { // an aggregate type
S s; // aggregate member
int k;
};
T t1 = { {1, 2}, 3 }; // traditional initialization
S s1 = { 1, 2 };
T t2 = { s1, 3 }; // sub-aggregate initialization
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When -library=no%Cstd is specified, the libCstd library, which implements

those headers, is not automatically linked with your program. To use any of the

features declared in the above headers, you must use the -I option to point to the

directory where the replacement headers are located, and you must link your

program with a library or set of object files containing the implementation of the

replacement headers.

You cannot reliably replace only a portion of the headers listed above, nor can you

reliably link libCstd with all or part of another library implementation. For

example, you cannot replace only the string classes and use libCstd for everything

else. Either use the library supplied with the compiler, or replace all of the

functionality listed above.

The remaining headers (<exception> , <new>, <typeinfo> , and all the headers

inherited from C) are integral to the compiler itself or to Solaris, and are not affected

by the -library=no%Cstd option. Linking of the library libCrun also is not

affected by the -library=no%Cstd option.

There is no mechanism to replace any of the functionality of libCrun . If you replace

the standard library, the code must be compiled with the versions of <exception> ,

<new>, and <typeinfo> supplied with the compiler. In standard mode (the default

mode) C++ programs must be linked with libCrun .

Note – This option is available to “use at your own risk.” Using your own version

of the C++ standard library might not produce optimal results.

Cache Versioning

The C++ compiler now has the ability to detect cache version differences and issue

the appropriate error message. The compiler marks each template cache directory

with a version string that uniquely identifies the template cache version. Subsequent

releases of the compiler will also use cache version strings, although these versions

may be different from the current version.

This compiler and future compilers will detect the version strings from within the

cache directories and issue an error as appropriate. For example, a future compiler

that uses a different template cache version string and processes a cache directory

produced by this release of the compiler might issue the following error.

SunWS_cache: Error: Database version mismatch
/SunWS_cache/CC_version
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Similarly, this release of the compiler issues an error if it encounters a cache

directory produced by a future compiler.

The template cache directories produced by the Sun WorkShop C++ compiler 5.0

compiler are not versioned. However, the Sun WorkShop 6 C++ compiler processes

these cache directories without an error or a warning. These cache directories are

converted to the cache directory format used by the Sun WorkShop 6 C++ compiler.

A template cache directory produced by the Sun WorkShop 6 C++ compiler or later

releases cannot be used by the Sun WorkShop C++ compiler 5.0. The Sun WorkShop

C++ compiler 5.0 is not capable of recognizing format differences and it will issue an

assertion.

Fortran Compilers

Sun WorkShop 6 includes the Sun WorkShop™ Compilers Fortran 77 and Sun

WorkShop™ Compilers Fortran 95.

The Fortran compilers in this Sun WorkShop 6 release support only versions 2.6, 7,

and 8 of the Solaris SPARC™ Platform Edition Operating Environment. For the Solaris

Intel IA-32 platform, Sun has discontinued development of Fortran compilers and

the Sun Performance Library. Sun does not offer Forte™ for High Performance

Computing or the Forte™ Fortran Desktop Edition (formerly known as Sun

Performance WorkShop Fortran) for the Solaris Intel IA-32 platform in this release.

You can contact The Portland Group (http://www.pgroup.com ) for information

about their line of software development tools for the Solaris IA-32 platform.
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Fortran 77 Compiler

TABLE 2-3 lists the new features available with the release of the Sun WorkShop 6

Fortran 77 compiler. Some of these features are described more completely in “New

Fortran Compiler Features” on page 52.

TABLE 2-3 Fortran 77 Compiler New Features

Feature Description

Effect of

FORM="BINARY"
on I/O

Operations

Specifying this new option in an OPEN(...) statement causes the file to

be treated as a sequential binary (unformatted) file with no record

marks. This enables data to be written and read as a continuous stream

of bytes, and provides compatibility with other vendor systems. It is

implemented in both the Fortran 95 and Fortran 77 compilers.

Debugging

Optimized Code

The restrictions on compiling with -g have been relaxed so that it is now

possible to compile at -O4 and -O5 or any of the parallelization flags

(-parallel , -explicitpar , -autopar ) with debugging (-g ).

New

Command-Line

Flags

The following new command-line flags appear in this release of f77 (see

the f77 (1) man page):

-aligncommon Aligns common block elements to specified byte

boundaries

-r8const Promotes single-precision data constants to REAL*8

-xmemalign Specifies general alignment of data elements

Expanded

Command-Line

Flags

The following f77 command-line flags have been expanded (see the

f77 (1) man page):

-fast Sets -O5, -fsimple=2, -xvector=yes,
-pad=common

-xprefetch Enables explicit pragma prefetch directives to force

generation of prefetch instructions on UltraSPARC

platforms

-xtypemap Includes an expanded set of possible data type

specifications

Cray-Style

Directives

AUTOSCOPEqualifier added to Cray-style parallelization directives.

Licensing The parallelization features of the Fortran 77 compiler require a Sun

WorkShop HPC license.

Hyper-Linked

Compiler

Diagnostics

f77 error messages in the Sun WorkShop Building window now have

hyperlinks to help pages that explain the messages.
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Fortran 95 Compiler

TABLE 2-4 lists the new features available with the release of the Sun WorkShop 6

Fortran 95 compiler. Some of these features are described more completely in “New

Fortran Compiler Features” on page 52.

TABLE 2-4 Fortran 95 Compiler New Features

Feature Description

Compliance The Fortran 95 compiler is fully compliant with the Fortran 95 standard.

New Command The Fortran 95 compiler is invoked by both the f90 and f95 command.

The f95 command is new. f90 is equivalent to f95 .

File Extensions The compiler will accept free-format source files with .f95 and .F95
extensions as well as .f90 and .F90.

Effect of

FORM="BINARY"
on I/O

Operations

Specifying this new option in an OPEN(...) statement causes the file to

be treated as a sequential binary (unformatted) file with no record

marks. The enables data to be written and read as a continuous stream of

bytes, and provides compatibility with other vendor systems. It is

implemented in both the Fortran 95 and Fortran 77 compilers. See the

FORTRAN 77 Language Reference.

Debugging

Optimized Code

The restrictions on compiling with -g have been relaxed so that it is now

possible to compile at -O4 and -O5 or any of the parallelization flags

(-parallel , -explicitpar , -autopar ) with debugging (-g ).

f77 Flags Most of the f77 compiler flags are now implemented in f95 . See the

f95 (1) man page for details. These include:

-erroff Turns off selected error messages

-errtags Displays error messages with tags

-ext_names Creates external names with or without

underscores

-fpp Specifies source code preprocessor

-loopinfo Shows which loops are parallelized

-sbfast Produces browser table information

-silent Suppresses compiler messages

-U Allows lowercase and uppercase

-u Implies IMPLICIT NONE

-xcrossfile Enables optimization across files

-xF Allows function-level reordering for Analyzer

-xinline Compiles functions inline

-xtypemap Specified default data sizes
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New Flags The following new flags are implemented in f95 :

-aligncommon Aligns common block elements to specified byte

boundaries

-mp=openmp Accepts OpenMP directives

-r8const Promotes single-precision constants to REAL*8

-xia Enables processing of INTERVAL data types

(recommended)

-xinterval Enables processing of INTERVAL data types

-xmemalign Specifies general alignment of data elements

-xrecursive Allows recursive calls without RECURSIVE
attribute

Expanded Flags The following f95 command-line flags have been expanded (see the

f95 (1) man page):

-fast

-xprefetch

-xtypemap

Sets -O5 -fsimple=2 -xvector=yes
-pad=common
Enables explicit pragma prefetch directives to force

generation of prefetch instructions on UltraSPARC

platforms

Includes an expanded set of possible data type

specifications

OpenMP This release of Fortran 95 implements the OpenMP interface for explicit

parallelization, including a set of source code directives, runtime library

routines, and environment variables. See the Fortran User’s Guide.

Cray-Style

Directives

AUTOSCOPEqualifier added to Cray-style parallelization directives.

Interval

Arithmetic

Extensions

This release of Fortran 95 implements extensions to support intrinsic

INTERVAL data types.

Licensing The parallelization features of the Fortran 95 compiler require a Sun

WorkShop HPC license.

Hyper-Linked

Compiler

Diagnostics

Sun WorkShop Building window now interprets f95 error messages as

live links into the online help.

TABLE 2-4 Fortran 95 Compiler New Features (Continued)

Feature Description
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New Fortran Compiler Features

The following sections describe some of the new Fortran compiler features in greater

detail.

Effect of FORM="BINARY" on I/O Operations

■ WRITEstatement—Data is written to the file in binary, with as many bytes

transferred as there is specified in the output list.

■ READstatement—Data is read into the variables on the input list, with as many

bytes transferred as demanded by the list. Because there are no record marks on

the file, there will be no “end-of-record” error detection. The only error detected

is end-of-file, or abnormal system errors.

■ INQUIRE statement—INQUIRE on a file opened with FORM="BINARY"returns the

following information:

FORM="BINARY"
ACCESS="SEQUENTIAL"
SEQUENTIAL="YES"
DIRECT="NO"
FORMATTED="NO"
UNFORMATTED="YES"
RECL= and NEXTREC= are undefined.

■ BACKSPACEstatement—Not allowed; returns an error.

■ ENDFILE statement—Truncates file at current position, as usual.

■ REWINDstatement—Repositions file to beginning of data, as usual.

OpenMP

(Fortran 95 only) This release of Fortran 95 implements the OpenMP interface for

explicit parallelization, including a set of source code directives, runtime library

routines, and environment variables. Preliminary documentation is available in the

OpenMP README. The OpenMP specifications can be viewed at

http://www.openmp.org/ .

A summary of all directives accepted by the Fortran compilers, including OpenMP,

can be found in Appendix E of the Fortran User’s Guide. See also the Fortran
Programming Guide for additional information on the parallelization features of the

Fortran compilers.

Note – The parallelization features of the Fortran compilers require a Sun

WorkShop HPC license.
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Interval Arithmetic Extensions

(Fortran 95 only) This release of Fortran 95 includes interval arithmetic extensions.

See “Fortran 95 Interval Arithmetic” on page 53.

Hyper-Linked Compiler Diagnostics

When you use Sun WorkShop to build and compile applications, f77 and f95
diagnostic messages in the Building window now have hyperlinks to help pages.

Clicking on the error message launches a help browser with additional information

about the specific error diagnostic.

Fortran 95 Interval Arithmetic

Support for intrinsic INTERVAL data types is a new feature in the Sun WorkShop 6

Fortran 95 compiler.

Two new compiler flags, -xia and -xinterval , tell the compiler to recognize

interval-specific languages extensions and generate the code to implement interval

instructions.

What Is Interval Arithmetic?

Interval arithmetic is used to evaluate arithmetic expressions over sets of numbers

contained in intervals. An interval is the set of all real numbers between and

including the interval’s lower and upper bound. Any interval arithmetic result is a

new interval that is guaranteed to contain the set of all possible resulting values.

With Sun WorkShop 6 Fortran 95, it is a simple matter to write interval programs to

compute rigorous bounds on the value of arithmetic expressions:

■ Declare variables to be type INTERVAL.

■ Write normal Fortran code using the intrinsic INTERVAL functions and operators,

relational operators, and format edit descriptors.

■ Compile the code using the -xia command-line option.

To achieve the best results, use existing interval algorithms that compute narrow

width interval results. Devising algorithms to compute narrow interval results is the

topic of interval analysis.
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Why Is Interval Arithmetic Important?

Interval arithmetic is important for the following reasons:

■ Interval arithmetic can be used to perform machine computations with

guaranteed bounds on errors from all sources, including input data errors,

machine rounding, and their interactions.

■ Interval algorithms can be developed that solve nonlinear problems, such as the

solution to nonlinear systems of equations and nonlinear programming.

As intervals become more widely used, libraries of interval solvers will be used

routinely to compute sharp interval solutions to linear and nonlinear problems,

while taking into account all sources of error. With these libraries, scientists,

engineers, and developers of commercial applications will be able to write programs

to solve problems that are currently out of reach.

Where Can I Get More Information?

See the Interval Arithmetic Programming Reference or the list of online resources in the

Interval Arithmetic readme.

dbx
TABLE 2-5 lists the new features available with the release of Sun WorkShop 6 dbx .

TABLE 2-5 dbx New Features

Feature Description

$firedhandlers ksh

variable

The read only ksh variable $firedhandlers has been

added. This variable can be used in conjunction with the

delete and handle r commands as an alternative to the

clear command. For more information, see Variables, delete
Command, and handler Command in the Using dbx

Commands section of the Sun WorkShop online help.

Partial clearing of

breakpoints

The clear command now facilitates partial clearing of In

Class, In Method, and In Function breakpoints. For more

information, see clear Command in the Using dbx

Commands section of the Sun WorkShop online help.
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Trace output Output of traces can be redirected to files. For more

information, see trace Command in the Using dbx
Commands section of the Sun WorkShop online help.

New dbx environment

variables

• The new dbx environment variable stack_find_source
controls whether dbx automatically moves up the call stack

to a frame with debuggable source code when the program

stops. For more information, see stack_find_source
Environment Variable in the Using dbx Commands section of

the Sun WorkShop online help.

• The new dbx environment variable

proc_exclusive_attach controls whether dbx can attach

to a process that is under the control of another debugger or

debugging tool. For more information, see

proc_exclusive_attach Environment Variable in the

Using dbx Commands section of the Sun WorkShop online

help.

• The new dbx environment variable step_granularity
controls whether the step and next commands work on

statements or lines or source code. For more information, see

step_granularity Environment Variable in the Using dbx

Commands section of the Sun WorkShop online help.

• The new dbx environment variable mt_scalable helps

debugging multithreaded applications with many LWPs

(lightweight processes) by reducing resource usage. For more

information, see mt_scalable Environment Variable in the

Using dbx Commands section of the Sun WorkShop online

help.

• The new dbx environment variable rtc_error_stack
determines whether stack traces show frames corresponding

to RTC internal mechanisms. For more information, see

rtc_error_stack Environment Variable in the Using dbx

Commands section of the Sun WorkShop online help.

• The new dbx environment variable rtc_inherit
determines whether runtime checking is enabled on child

processes that are executed from the debugged program. For

more information, see rtc_inherit Environment Variable

in the Using dbx Commands section of the Sun WorkShop

online help.

• The new dbx environment variable rtc_use_traps
enables a workaround for the eight megabyte code limitation

on runtime checking. For more information, see

rtc_use_traps Environment Variable in the Using dbx

Commands section of the Sun WorkShop online help.

TABLE 2-5 dbx New Features (Continued)

Feature Description
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Sun WorkShop 6

TABLE 2-6 lists the new features available with the release of Sun WorkShop 6. Some

of the features are described in greater detail in the sections following the table.

Breakpoints in C++ member

functions

Breakpoints in C++ inlined member functions work correctly.

This includes proper evaluation of handler conditions (-if ).

LWP-related commands now

always available

LWP-related commands are now always available, not just

when you are debugging a multithreaded application. For

more information, see lwp Command and lwps Command in

the Using dbx Commands section of the Sun WorkShop

online help.

Interrupting a running

process

When Control-C does not seem to stop a hung process, the

third consecutive Control-C will force the process to stop by

other means. See Interrupting a Running Process in the Using

dbx Commands section of the Sun WorkShop online help.

Full line number information Full line number information is now recorded when you

compile with the -g and -O options. You can now use the

step command and next command to step through

optimized code, although the current line will jump forward

and back due to code scheduling. The values of variables

printed from within dbx continue to be unreliable in

optimized code.

TABLE 2-6 Sun WorkShop 6 New Features

Feature Description

Text Editing

Balloon expression evaluator The balloon expression evaluator instantly shows you the

current value of the expression at which your cursor is

pointing in your text editor.

NEdit and Vim text editors The NEdit and Vim text editors are new integrated text

editors for this release.

TABLE 2-5 dbx New Features (Continued)

Feature Description
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Debugging a Program

Button editor The Button Editor now allows you to customize the toolbars

in your editor window and the Debugging window, in

addition to adding, removing, and editing buttons in the

Custom Button window.

Debugging window The Data History pane has been replaced with tabs for Data

History and Program I/O, and an optional Data Display tab.

The radio buttons for switching the Sessions and Threads

panes have been replaced by tabs for Sessions, Threads, and

Breakpoints.

Debugging Options dialog

box

The Category list box has been replaced with tabs at the

right side of the dialog box for switching among the

categories of options.

New debugging options You now choose to direct program input or output to the

Program I/O tab in the Debugging window.

You can now choose to have the call stack pop to the first

debuggable source code if execution stops in a function in

your program that is not debuggable source code.

You can now choose to set the step granularity to Line, so

that a single next command steps through a line regardless

of the number of statements it includes.

By default, the State, Stopped In, Evaluation Context, and

number of sessions information is no longer displayed

below the toolbar, but you can choose to display this

information.

You can choose to not have the debugger warn you if the

main () module of your program is not compiled with

debugging information.

You can choose to have the Data Display window shown as

a tab in the Debugging window or as a separate window.

You can delay the loading of modules compiled with -xs
until the debugging information for these modules is

needed, rather than having the modules loaded during the

startup of the debugging session.

If you want to debug processes with a large number (up to

300) LWPs (lightweight processes), you can now set

debugging to be conservative in its resource usage when

doing so.

You can choose not to have the debugger check that dbx has

exclusive control of the program being debugged.

TABLE 2-6 Sun WorkShop 6 New Features (Continued)

Feature Description
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Text Editing

The following two sections describe the new Sun WorkShop 6 text editing features.

Balloon Expression Evaluator

The balloon expression evaluator instantly shows you the current value of the

expression at which your cursor is pointing in your text editor. You can also see the

type of expression and dereference the pointer through the balloon expression

evaluator feature. For more information, see Using the Balloon Expression Evaluator

in the Text Editing section of the online help.

NEdit and Vim Text Editors

Text editors are the center of the Sun WorkShop integrated development tool set that

includes building, debugging, and browsing. The Sun WorkShop programming

environment makes it possible to evaluate expressions, set breakpoints, and step

through functions from your text editor.

You can choose to allow the debugger to exclude certain

shared libraries that are critical to dbx functionality.

Removed debugging option The option to allow watchpoints in multithreaded programs

has been removed from the Debugging Options dialog box.

Working With Projects

Projects and worksets This release of Sun WorkShop uses projects to track the files,

programs, and targets associated with your development

projects and to build your programs without your needing

to write a makefile.

New Man Pages

makeprd (1) Sun WorkShop project file builder

nedit (1) Motif user interface style text editor

vim (1) Vi improved; a text editor for programmers

xemacs (1) Emacs: The Next Generation

TABLE 2-6 Sun WorkShop 6 New Features (Continued)

Feature Description
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NEdit, a plain-text editor with a graphical user interface for X/Motif systems, and

Vim, an improved version of the vi standard text editor on UNIX systems, are new

integrated text editors in this release. The following is a list of integrated text editors

provided with Sun WorkShop 6:

■ NEdit (version 5.1)

■ XEmacs (version 20.4 or compatible versions)

■ GNU Emacs (version 19.28 or compatible versions)

■ Vi

■ Vim (version 5.3 with graphical user interface option)

For more information about each editor’s options, see:

■ The online documentation available from the Help menu in the editor’s menu bar

■ Text Editor Options Dialog Box in the Text Editing section of the online help

Debugging a Program

The following sections describe new program debugging features.

Button Editor

The Button Editor now allows you to customize the toolbars in your editor window

and the Debugging window, in addition to adding, removing, and editing buttons in

the Custom Button window.

For more information, see Toolbar Options.

Debugging Window

The following sections describe changes made in the Debugging window.

Session Status and Context Information

By default, the State, Stopped In, Evaluation Context, and Number of Sessions

information no longer appears below the toolbar. If you want to display this

information, you can select Show 3 Line Context/Status Area at Top of Display on

the Window Layout tab in the Debugging Options dialog box. For more information,

see Displaying Session Status and Context Information in the Using the Debugging

Window section of the Sun WorkShop online help.
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Data History Pane

The Data History pane has been replaced with tabs for Data History and Program

I/O, and an optional Data Display tab:

■ The Data History tab displays the Data History pane. For more information, see

Data History Tab in the Using the Debugging WIndow section of the Sun

WorkShop online help.

■ The Program I/O tab displays program input and output within the Debugging

window rather than in a separate Program Input/Output window. (For more

information, see Program I/O Tab in the Using the Debugging Window section of

the Sun WorkShop online help.) This is now the default behavior, but you can use

the Program output section of the Debugging Output tab of the Debugging

Options dialog box to choose where you want to direct program input and

output. For more information, see Redirecting a Program’s Input/Output in the

Using the Debugging Window section of the Sun WorkShop online help.

■ The Data Display tab is included (instead of a separate Data Display window) if

you select Tab in Debug Window in the Data Display Window Shown As section

on the Data Display Window tab in the Debugging Options dialog box. For more

information, see Data Display Tab and Choosing How to Show the Data Display

in the Using the Debugging Window section of the Sun WorkShop online help.

Sessions and Threads Panes

The radio buttons for switching the Sessions and Threads panes have been replaced

by tabs for Sessions, Threads, and Breakpoints:

■ The Sessions tab displays the Sessions pane. When you press the right mouse

button over this tab, a popup menu is displayed. For more information, see

Sessions Tab in the Using the Debugging Window section of the Sun WorkShop

online help.

■ The Threads tab displays the Threads pane. For more information, see Threads

Tab in the Using the Debugging Window section of the Sun WorkShop online

help.

■ The Breakpoints tab displays a scrolling list of breakpoints and tracepoints

assigned in your program. When you press the right mouse button over this tab,

a popup menu is displayed that lets you enable, disable, delete and show source

instantly for each breakpoint. The popup menu includes an Add item that

displays the separate Breakpoints window in which you add, enable, disable,

change, and delete breakpoints. For more information, see Breakpoints Tab in the

Using the Debugging Window section of the Sun WorkShop online help.
60 What’s New in Sun WorkShop 6 update 1 • October 2000



Debugging Options Dialog Box

The Debugging Options dialog box contains the following new features.

Category Tabs

The Category list box in the Debugging Options dialog box has been replaced with

tabs at the right side of the window for switching among the categories of options.

New Program Output Option

You now direct program input or output to the Program I/O tab in the Debugging

window. As before, you can also direct it to a separate Program I/O window, to the

dbx Commands window, or to a custom pty . For more information, see Redirecting

a Program’s Input/Output in the Using the Debugging Window section of the Sun

WorkShop online help.

New Call Stack Option

During debugging, if your program was not compiled with -g , execution might stop

in a function in the program that is not debuggable source code. You can now choose

to have the call stack pop to the first debuggable source code in this case. For more

information, see Going Up the Stack When Execution Stops in the Using the

Debugging Window section of the Sun WorkShop online help.

New Stepping Option

By default, the step granularity for debugging is set to Statement, so that if more

than one statement is included in a source code line, it requires the same number of

commands to step through that line. You can now choose to set the step granularity

to Line, so that a single next command steps through a line regardless of the number

of statements it includes. For more information, see Setting Step Granularity in the

Using the Debugging Window section of the Sun WorkShop online help.
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New Window Layout Option

By default, the State, Stopped In, Evaluation Context, and number of sessions

information is no longer displayed below the toolbar. If you want to display this

information, you can select Show 3 Line Context/Status Area at Top of Display on

the Window Layout tab in the Debugging Options dialog box. For more information,

see Displaying Session Status and Context Information in the Using the Debugging

Window section of the Sun WorkShop online help.

New Window Behavior Option

By default, the debugger warns you if the main () module of your program is not

compiled with debugging information. You can choose to not have this warning

displayed. For more information, see Being Warned If Your main () Module is Not

Compiled With Debugging Information in the Using the Debugging Window section

of the Sun WorkShop online help.

New Data Display Option

You can choose to have the Data Display window shown as a tab in the Debugging

window or as a separate window. For more information, see Choosing How to Show

the Data Display in the Using the Debugging Window section of the Sun WorkShop

online help.

New Debugging Performance Option

You can delay the loading of modules compiled with -xs until the debugging

information for these modules is needed, rather than having the modules loaded

during the startup of the debugging session. This may shorten the debugging

startup time when modules have been compiled with -xs . By default, this

debugging option is set to on. For more information, see Delaying Loading of

Modules Compiled with -xs in the Using the Debugging Window section of the Sun

WorkShop online help.

New Forks and Threads Option

If you want to debug processes with a large number (up to 300) of LWPs

(lightweight processes), you can now set debugging to be conservative in its

resource usage. When doing so, debugging performance might be slowed. For more

information, see Debugging a Large Number of LWPs in the Using the Debugging

Window section of the Sun WorkShop online help.
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New Advanced Options

By default, the debugger checks that dbx has exclusive control of the program being

debugged. It prevents dbx from attaching to the process if another tool is already

attached to the process. You can now turn off this behavior. For more information,

see Checking that dbx has Exclusive Control of the Program in the Using the

Debugging Window section of the Sun WorkShop online help.

By default, the debugger disallows the exclusion of certain shared libraries that are

critical to dbx functionality. You can now choose to allow these libraries to be

excluded, in which case you can debug core files only. For more information, see

Requiring Inclusion of Critical dbx Libraries in the Using the Debugging Window

section of the Sun WorkShop online help.

Working With Projects

This release of Sun WorkShop uses projects to track the files, programs, and targets

associated with your development projects and to build your programs without

your needing to write a makefile. A project is a list that includes the files and the

compiler, debugger, and build-related options used to build an executable, a static

library or archive, a shared library, a Fortran application, a complex application, or a

user makefile application.

In previous versions of Sun WorkShop, a workset was used instead of a project.

Projects still have some workset features (there continue to be menu picklists that

make it easy to access directories and files associated with a project), but a project

includes more information about your program, such as which source files you want

to build and how you want them built. If you have Sun WorkShop worksets, you can

automatically convert your worksets to Sun WorkShop 6 projects when you load

them. For more information, see Converting a Workset to a Project in the Working

With Projects section of the online help.

When you start Sun WorkShop, the Welcome to Sun WorkShop dialog box opens and

gives you immediate access to Sun WorkShop projects and the project wizard. Sun

WorkShop also has project functions available from the Project Menu in the

WorkShop Main Window to help you complete the following tasks:

■ Create a new project or build a simple program using the project wizard and your

own makefile or a makefile that Sun WorkShop creates for you (see Creating a

New Project in the Working With Projects section of the online help)

■ Change existing project settings, including how you want your project compiled

and whether you want source browsing information generated (see Editing a

Project and Edit Current Project Window in the Working With Projects section of

the online help)
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You can also choose to use the Sun WorkShop 6 programming environment without

loading a project. Picklists keep track of the files, programs, directories, and targets

associated with your development projects (see WorkShop Targets in the Building

Programs section of the online help for more information). You can access each file,

build the target, and debug the executable from the menus in the WorkShop Main

Window. Build target information cannot be edited because it is not persistent;

rather, it changes as you access, add, and remove build targets.

Sun WorkShop TeamWare 6

TABLE 2-7 lists the new features available with the release of Sun WorkShop™

TeamWare 6. Some of the features are described in greater detail in the sections

following the table.

TABLE 2-7 Sun WorkShop TeamWare 6 New Features

Feature Description

Autofreezepointing Autofreezepointing creates a freezepoint file for you before or

after specific transactions. You can select the time that you

want freezepoint files created: before or after bringovers,

putbacks, undo actions, or resolve actions.

Versioning customized menu The customized menu feature adds a new menu in the

Versioning window titled “Customized,” which provides

access to your own commands. For information about

creating a customized menu, see Creating a Customized

Menu in the Managing Files section of the online help.

Delta comments This new option adds delta comments to transaction output

and email notification, including delta number, owner, and

comments. In Configuring, choose Workspace ➤ Bringover

Create/Bringover Update/Putback and check the Delta

Comments box, or use the -d option with the bringover or

putback command.

Merging diff navigator The diff navigator appears between two unmerged files. You

can click on the slide boxes on either side of the diff

navigator to scroll through either file, or click on the arrows

on the top or bottom to move the same distance in both files.

Configuring Menu

Reorganization

Sun Workshop 6 TeamWare has implemented changes to the

Configuring user interface.
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Configuring Menu Reorganization

Sun Workshop TeamWare 6 includes the following changes to the menus.

Putback Validation When you turn on putback validation, only putbacks are

allowed to the workspace. You can control which users can

perform a putback and require that they have a specific

password.

SCCS Admin Flags Allows you to set SCCS admin flags for a file.

Workspace integrity check New option to workspace command:

check [ - W ] [ - s ] wsname ... checks files, access

modes, parent-child relationships, and condition of the

history file. The command exits with the following values:

0 = workspace is okay or 1 = error.

Workspace History Viewer Sun WorkShop TeamWare now includes an easy way to view

the information in the workspace history file.

Workspace labels With this feature, you can give a workspace a descriptive

name that is more meaningful to your team. Choose

Workspace ➤ Properties and select the Description tab.

New man page description (4)

TABLE 2-8 Sun WorkShop TeamWare 6 Menu Changes

Sun WorkShop TeamWare 2.2 Sun WorkShop TeamWare 6

Configuring

File ➤ Load Parent Workspace ➤ Load Parent

File ➤ Load Children Workspace ➤ Load Children

File ➤ Create Empty Child Workspace Workspace ➤ Create Child

Edit ➤ Delete Workspace ➤ Delete

Edit ➤ Rename Workspace ➤ Rename

Edit ➤ Parent Workspace ➤ Reparent

Edit ➤ Update ➤ Nametable Workspace ➤ Update Nametable

Transactions ➤ Bringover ➤ Create Actions ➤ Bringover Create

TABLE 2-7 Sun WorkShop TeamWare 6 New Features (Continued)

Feature Description
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Putback Validation

When you turn on putback validation, only putbacks are allowed to the workspace.

The user is prompted for a password (Integration Request Identifier) before

performing a putback. This feature only records the Integration Request Identifier, it

does not check it. To check the Integration Request Identifier, you must write your

own validation program. For more information, see Protecting Workspaces With

Putback Validation in the Managing Workspaces section of the online help.

SCCS Admin Flags

You can set SCCS admin flags for a file by using Versioning, choose File ➤ File Info.

For example, if you want Versioning to prompt for MRs (modification request

strings) during putbacks, put the name of a validation program in the Validation

Program box.

Transactions ➤ Bringover ➤ Update Actions ➤ Bringover Update

Options ➤ Workspace Workspace ➤ Properties

Options ➤ Workspace ➤ Edit Locks Workspace ➤ Edit Locks

NEW View ➤ Refresh

NEW Workspace ➤ Properties ➤ Freezepointing

NEW Workspace ➤ Properties ➤ Putback Validation

NEW Options ➤ Configuring ➤ Load Children:

Selective/All

Versioning

NEW File ➤ File Info

NEW Commands ➤ Uncheckout

TABLE 2-8 Sun WorkShop TeamWare 6 Menu Changes (Continued)

Sun WorkShop TeamWare 2.2 Sun WorkShop TeamWare 6
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Workspace History Viewer

Sun WorkShop TeamWare now includes an easy way to view the information in the

workspace history file (choose Workspace ➤ View History). In the Workspace

History Viewer, you can view the transaction history of a workspace, transaction

details, comments, and the command log. You can sort and filter the entries and

search the comments and command log.

Sun WorkShop Visual 6

TABLE 2-9 lists the new features available with the release of Sun WorkShop Visual 6.

Some of the features are described in greater detail in the sections following the

table.

Swing Support

Sun WorkShop 6 Visual now has the ability to generate Java™ Swing code in

addition to Java 1.0 and 1.1 code. As well as generating appropriate Swing

components for the Motif widgets, Sun WorkShop 6 Visual has increased the range

of supported mappable resources: It is now possible to generate appropriate Swing

code for toggles that contain images, shell icons, shell resize and delete response, the

contents of lists, and rowcolumn entry alignment, among other extensions.

TABLE 2-9 Sun WorkShop Visual 6 New Features

Feature Description

Swing Support Sun WorkShop 6 Visual now has the ability to generate Java

Swing code in addition to Java 1.0 and 1.1 code. As well as

generating appropriate Swing components for the Motif

widgets, Visual has increased the range of supported

mappable resources: It is now possible to generate

appropriate Swing code for toggles that contain images, shell

icons, shell resize and delete response, the contents of lists,

and rowcolumn entry alignment, among other extensions.

Enhanced Windows Support Sun WorkShop Visual has added support for mapping X

events to Windows MFC.

Integration With Sun

WorkShop Projects

Sun WorkShop Visual works with Sun WorkShop project

wizards to help create projects with graphical user interfaces.
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The MWT class library, which maps Motif components into Java where the standard

classes lack equivalence, has been ported to Swing in order to provide a more

consistent look and feel. The dependence on the MWT to provide a Motif-compatible

interface has been reduced as some of the Motif components are now mapped

directly into an appropriate Swing component.

The Java Layout emulation widgets have been reworked where necessary to provide

a more consistent behavior with respect to Java Layout characteristics.

As part of a move towards supporting cross-platform code for third- party (non-

Motif) components, Visual now has the ability to specify default base classing for

any integrated component. The classing can be on a general language basis or for

specific variants. For example, it is possible to specify in a general way the proposed

default class for Java, as well as Java 1.0, Java 1.1, and Swing-specific classing.

Proposed component MFC classing can also be specified. The mechanisms address

the problem wherein each given third-party component required individual manual

configuration in order to create the right kind of object in the target language. Third-

party specific resources are not mapped. The mechanisms do not address the

following situations:

■ A given component needs to be mapped into multiple native objects

■ A compound component can be mapped by consideration of the constituent built-

in parts.

Enhanced Windows Support

Sun WorkShop Visual 6 has added the following support for mapping X events to

Windows MFC.

TABLE 2-10 Sun WorkShop Visual Mappings for X Events to Windows MFC

MouseMotion Generates a generic handler for any mouse movement with or

without button press

ButtonPress Generate all three handlers: Left, Center, and Right pressed

handlers

ButtonRelease Generate all three handlers: Left, Center, and Right release

handlers

EnterWindow MouseActivate

ExposureMask EraseBkgnd

KeyPressMask WM_KEYDOWN

KeyRelease WM_KEYUP

KeymapstateMask WM_SYSKEYUP/WM_SYSKEYDOWN
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Sun Performance Library

Sun Performance Library™ is a set of optimized, high-speed mathematical

subroutines for solving linear algebra and other numerically intensive problems. Sun

Performance Library is based on a collection of public domain applications available

from Netlib at http://www.netlib.org . These routines have been enhanced and

bundled as the Sun Performance Library.

TABLE 2-11 lists the new features available with the Sun WorkShop 6 release of the

Sun Performance Library. Some of the features are described in greater detail in the

sections following the table.

LeaveWindowMask WM_KILL_FOCUS

ResizeRedirect WM_SIZE

PropertyChangeMask ON_WM_PAINT

VisibilityChangeMask WM_SHOWWINDOW

TABLE 2-11 Sun Performance Library New Features

Feature Description

Support for LAPACK 3.0 LAPACK 3.0 subroutines have been added. The previous

version of Sun Performance Library was based on LAPACK

2.0. The current version of Sun Performance Library still

maintains compatibility with LAPACK 2.0 and LAPACK 1.x.

Sparse solver package The sparse solver package provides routines for solving

sparse matrices (symmetric, structurally symmetric, and

unsymmetric coefficient matrices) using direct methods and a

choice of fill-reducing ordering algorithms, including user

specified orderings.

TABLE 2-10 Sun WorkShop Visual Mappings for X Events to Windows MFC (Continued)
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Fortran 95 Language Feature Support

By including the f95 statement USE SUNPERFin your application, you can use the

Sun Performance Library modules and definitions with the following features:

■ Type independence. In Fortran 77 routines, you must specify the type as part of

the name. In Fortran 95, a routine for a specific data type can be determined by

the data type of the arguments passed to the routine.

■ Compile-time checking. In Fortran 77, it is generally impossible for the compiler

to know what parameters should be passed to a particular routine. In Fortran 95,

the USE SUNPERFstatement allows the compiler to know what the number, type,

size, and shape of each parameter to each Sun Performance Library routine

should be. It can check your calls against the expected value and identify errors

during compilation.

■ Optional parameters. In Fortran 77, all parameters must be specified in order for

all routines. Fortran 95 allows some parameters to be optional. In Sun

Performance Library, all increment parameters (INCX, INCY, and so on),

workspaces, leading dimensions (LDA, LDB, and so on), and length or size

parameters are optional.

For information on using these features and examples, see the Sun Performance
Library User's Guide.

UltraSPARC III support This release supports the UltraSPARC III instruction set

architecture. To use the code that is specific to UltraSPARC

III, compile with -xarch=v8plusb for 32-bit code or

-xarch=v9b for 64-bit code.

Fortran 95 Language Feature

Support

This release supports Fortran 95 language features. You can

use the Sun Performance Library modules and definitions by

including the f95 statement USE SUNPERFin the code.

Changes to Sun Performance

Library Licensing

Sun Performance Library is no longer licensed. However, you

should continue to use -xlic_lib=sunperf to ensure that

the application links with the correct support libraries, and to

ensure the correct version of Sun Performance Library is

selected.

TABLE 2-11 Sun Performance Library New Features (Continued)

Feature Description
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Changes to Sun Performance Library Licensing

Sun Performance Library is no longer licensed. However, you should continue to

link using -xlic_lib=sunperf rather than -lsunperf . Use

-xlic_lib=sunperf to ensure that the following occurs:

■ The application is linked with the correct support libraries. In this release, Sun

Performance Library is compiled with Fortran 95 instead of Fortran 77. Using

-xlic_lib will correctly link in the Fortran 95 runtime libraries instead of the

Fortran 77 runtime libraries.

■ The correct version of Sun Performance Library is used. There are different

versions of Sun Performance Library to support programs built with and without

-subparallel and for different values of -xarch . Using -xlic_lib=sunperf
will cause the driver to use the version of Sun Performance Library that best

matches your command line options.

Sampling Analyzer

Sun WorkShop 6 Sampling Analyzer is a complete rewrite of the Analyzer that was

provided with Sun WorkShop 5.0.

TABLE 2-12 lists the new features available with the release of the Sun WorkShop 6

Sampling Analyzer. Some of these features are described in greater detail in the

sections following the table. See also “Additional Changes” on page 74.

TABLE 2-12 Sampling Analyzer New Features

Feature Description

Function List as Primary

Display

The Function List is the primary display and is displayed by

default when the Analyzer is invoked.

Multiple Metrics The Function List displays multiple metrics at the same time,

instead of requiring you to select one category at a time to

view. The Function List can also display metrics as values or

a percentage.

Summary Metrics Window A new Summary Metrics window, accessed from the View

menu, displays all metrics recorded for a selected function,

both as values and percentages. The contents of the Summary

Metrics window are independent of what appears in the

function list display.
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Function List as Primary Display

The Function List is the primary display, and is displayed by default when the

Analyzer is invoked.

Because the Function List can display multiple types of metrics at the same time, the

Data list option menu has been redesigned to change only the display type. The

Display list option menu has been removed.

You can now show metrics in the Function List as absolute values in seconds or

counts, or a percentage of the total program metric, or both. By invoking a Select

Metrics dialog box from the Function List display, you can do any of the following:

■ Select the metrics displayed in the Function List

■ Display metrics as counts, percentages, or both

■ Specify which metric is used to sort the Function List

■ Reorder the list

Callers-Callees Window From the Function List, you can access a new Callers-Callees

window that shows how metrics are attributed from the

callees of a selected function and to the callers of that

function.

Generate Annotated Source

Code

You can now generate annotated source code for a selected

function and display the results in an edit window.

Generate Annotated

Disassembly

You can generate annotated disassembly for the selected

function and display the results in an edit window.

Filter Data by Samples,

Threads, LWPs

You can now use the Select Filters dialog box to filter data by

samples, threads, LWPs, or any combination of these. All

displays and windows are updated to show data from the

selected subset only.

Thread Synchronization

Delay Metrics

Two thread synchronization delay metrics are now available:

a count of synchronization events exceeding the designated

threshold, and the aggregate delay from those events. For

more information about metrics, see “Metrics” on page 74.

Load Multiple Experiments You can now load multiple experiments into the Analyzer at

the same time. Their combined metrics appear in the

Function List display.

TABLE 2-12 Sampling Analyzer New Features (Continued)

Feature Description
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Callers-Callees Window

From the Function List, you can access a new Callers-Callees window that shows

how metrics are attributed from the callees of a function and to the callers of that

function. The Caller-Callees window shows the selected function in the center of the

display, with callers of that function in the panel above and callees of the function in

the panel below. For the selected function, the attributed metric represents usage

within the function itself. For the callers above, it represents usage within the

selected function and all functions it calls, as attributed up the callstack to its callers.

For the callees below, it represents the proportion of the callee's metric that is

attributable to calls from the selected function.

You can navigate through the program's structure in the Callers-Callees window by

clicking on a function in either the caller panel or the callee panel; the display

recenters on the newly selected function.

Generate Annotated Source Code

You can now generate annotated source code for a selected function and display the

results in an edit window. Source code is annotated with per-line metrics, using the

same set of metrics as the Function List. The source code also contains compiler

parallelization commentary and Fortran 95 copyin and copyout commentary

interleaved with the source. Source code display requires compiling with -g and

will work for optimized code (-g no longer disables optimizations and

parallelization).

Generate Annotated Disassembly

You can now generate annotated disassembly for a selected function and display the

results in an edit window. Disassembly is annotated with per-instruction metrics,

using the same set of metrics as the Function Display. Disassembly also contains

compiler commentary and interleaved source code.
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Metrics

The following new metrics or changes to existing metrics are provided with Sun

WorkShop 6 Analyzer:

■ Execution profile data is now called clock-based profiling. Execution profile data

always includes called-function times.

■ Histogram data is now called exclusive metrics.

■ Cumulative data metrics are now called inclusive metrics.

■ Clock-based profile data generates the following metrics:

■ Total LWP time

■ User CPU time

■ System CPU time

■ System wait time

■ Text-page fault time

■ Data-page fault time

■ Wall-clock time

■ Thread synchronization delay tracing, a new kind of data, is provided that

generates the following metrics:

■ A count of synchronization events exceeding the designated threshold

■ The aggregate delay from those events.

These metrics are not collected by default.

Additional Changes

The Sun WorkShop 6 Sampling Analyzer provides the following additional changes:

■ You can no longer select a subset of samples by clicking on them in the Overview

display. The Select Samples text box and arrow buttons are no longer part of the

Analyzer, and selection commands no longer appear in the View menu. You must

do all filter selection of samples, threads, and LWPs in the Select Filters dialog

box.

■ You cannot delete an experiment record from inside the Analyzer. The

Experiment ➤ Delete command has been changed to Experiment ➤ Drop. Use this

command to drop an experiment from the Analyzer. The experiment record

remains on disk until you remove it with the er_rm command.

■ The format of er_export ASCII data has been changed. (er_export is used

only for debugging.)
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Installation

TABLE 2-13 lists the new installation features available with the release of Sun

WorkShop 6.

Documentation in HTML

The manuals, man pages, and readme files in Sun WorkShop 6 and Sun WorkShop

TeamWare 6 are available in HTML as well as in text files. The online help is now in

HTML.

To view Sun WorkShop 6 documentation that is available in HTML format, you must

use Netscape™ Communicator 4.0 or a compatible Netscape version. Netscape

Communicator is included in the Solaris™ 7 Operating Environment and the

Solaris™ 8 Operating Environment.

If you are running the Solaris 2.6 Operating Environment and you do not have

Netscape Communicator 4.0 or a compatible version, you can download Netscape

Communicator 4.7 from the following Netscape Communications Corporation Web

site:

http://www.netscape.com/download/index.html

Sun WorkShop online help (in HTML) requires that you have JavaScript™ enabled,

which is a setting in Netscape preferences.

To access the installed Sun WorkShop 6 documentation in HTML format, point your

browser at the following file:

file:/opt/SUNWspro/docs/index.html

If your Sun WorkShop software is not installed in the /opt directory, contact your

system administrator for the equivalent path on your system.

TABLE 2-13 Installation New Features

Feature Description

Web Start Web Start is the new installation software.

FLEXlm 7.0b FLEXlm 7.0b is the license manager software provided with

the Sun WorkShop 6 programming environment.
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